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Welcome 

Welcome to the reviewer’s guide for the Xerox DocuShare content management platform, 

version 6.5. This guide provides an overview of the DocuShare products and add-on modules, 

as well as detailed information on key product capabilities. 

This Reviewer’s Guide is primarily for those who would like to test and review core features of 

the DocuShare product line, including DocuShare Express, DocuShare, and DocuShare CPX. 

The bulk of this guide provides recommended tests to give you a first view of those features, 

and it also includes a brief overview of more advanced, add-on DocuShare functionality. 
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Introduction 

The Xerox DocuShare content management platform provides organizations of any size—

from small workgroups to global enterprises—with a suite of product capabilities to address a 

wide range of business needs. DocuShare differentiates itself by offering one unified, easily 

deployed platform, with three distinct products: 

• DocuShare Express delivers content management software tailored specifically for 

the SMB market to help manage both paper and digital business critical documents 

with ease and affordability. 

• DocuShare provides document management, collaboration, image capture, and Web 

publishing capabilities to support ad hoc information sharing across the enterprise. 

• DocuShare CPX extends beyond basic content services to meet end-to-end enterprise 

content management (ECM) requirements, including certified records management, 

sophisticated collaboration, and workflow capabilities for better governance and 

transformation of paper-centric processes into fully automated business applications. 

The Xerox DocuShare content management platform is a highly-scalable Java 2EE application 

designed for large volumes of content, users, and traffic. This common, easily extensible 

platform enables organizations to rapidly broaden their DocuShare deployment as their 

needs grow. 

Flexible levels of login access—Guest, Read-Only, DocuShare, and DocuShare CPX—allow 

businesses to control access to functionality based on operational requirements. Upgrading 

users to higher levels of access or moving from a basic DocuShare installation to DocuShare 

CPX works with a simple license key, eliminating content migration, system downtime, and 

service interruption. 
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User Access Levels 

 

Xerox DocuShare is a proven technology that has been deployed to thousands of customers 

worldwide. DocuShare comes from Xerox Global Services, a leader in imaging and document 

management who offers deep and validated experience through world-class services, 

deployment, and support. 
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Product Features 

DocuShare Express, DocuShare, and DocuShare CPX offer businesses a flexible, easy-to 

deploy, Web-based software application that delivers sophisticated yet personalized content 

management capabilities to every knowledge worker. The DocuShare platform enhances the 

productivity and efficiency of knowledge workers across the organization with its unified and 

consistent user interface, industry-leading feature set, innovative personalization capabilities, 

virtually limitless scalability, and unprecedented performance.  

The DocuShare platform offers: 

• Trademark ease of use, administration, and deployment  

• Cross-platform support with Web browser access providing seamless integration into 

any environment 

• Enterprise-class scalability to support organizational and informational growth  

• Sophisticated capabilities, including workflow, collaboration, security, and federated 

search across multiple servers  

• State-of-the-art security and tracking, to enable the secure sharing of information at 

any level in the enterprise 

• High-performance imaging with capture rates of more than 1000 images per minute 

(ipm) in continuous operation mode 

• Support for over 50 million documents per server 

• Multiple user access levels to support a wide variety of user access requirements 

•  “Guest” access to allow widespread viewing of content, without requiring a login (for 

both intranet and public-facing DocuShare websites) 

• Multiple content entry points including: fax servers, scanning stations, and 

multifunction printers (MFPs); electronic forms (e-forms); and email 

• Rich developer toolset to enhance business application integration  

• Content control and easy information capture for corporate weblogs (blogs) and wikis 

• Integration with a broad range of imaging and scanning devices, making paper 

documents as easy to manage as digital files  

• High-capacity indexing with the Autonomy search engine 
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• An enhanced user experience with the downloadable DocuShare desktop Client, 

including configuration tools to push the application out to all users quickly and easily 

• Portal integration for convenient access to DocuShare and DocuShare CPX sites from 

Microsoft SharePoint and JSR168-compliant portals 

•  Audit trails, additional permission levels, and optional records management 

(available as an add-on to DocuShare CPX) to meet corporate and industry 

compliance requirements 

Core DocuShare Features 

The DocuShare platform provides comprehensive features for content management, image 

capture and processing, collaboration, workflow and business process automation, and web 

publishing. Refer to the Feature Comparison section for a list of the features in each product. 

Content Management 

• Core content library features, such as: document check-out/check-in; version control; 

publishing of “preferred” versions; and version history enable easy document 

management 

• Document- and version-based permissions for controlling access to content 

• Industry-leading full text and metadata search capabilities speed finding business-

critical information 

• PDF conversion feature provides conversion of supported document types for easy 

document exchange of documents among users, regardless of the original document 

format 

• Personal portal, My DocuShare, allows you to manage personal content as well as 

access site content from a single location 

• Access tracking (or audit trail) captures the activities of all registered user levels on 

each DocuShare object, providing a complete history of changes 

• Integration with Microsoft Office applications allows users to work using familiar 

desktop tools 

•  WebDAV integration allows users to work in desktop applications across platforms 

• Optional Microsoft Outlook integration enables storing, managing, indexing, and 

drag-and-drop uploading of emails/email attachments to DocuShare from Outlook 

•  Optional records management helps companies meet compliance requirements by 

securely storing content as records, according to a retention schedule 
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Use Case—A small, but growing services company needs a better way to share information 

internally. The company has reams of documents, including legal contracts and many large 

documents. Employees spend hours looking for information, for example when a customer 

calls. To help save time, the company sets up DocuShare with a simple collection structure 

organized around departments. Workers start uploading documents so they can easily find 

them later with a quick text search. They also save versions of documents, such as contracts, 

so they can go back to older versions, if necessary. Larger amounts of documents such as 

customer records are dragged and dropped in bulk from PC hard drives with the DocuShare 

Client. Employees can log in from home or the road, so salespeople can get materials while 

traveling, and other staff who telecommute can continue working on documents from home. 

Image Capture and Processing 

• Built-in direct scan to DocuShare functionality for quick capture of paper documents 

into a searchable electronic database that can be organized into collections, assigned 

access permissions and security protocols, and made available for search and retrieval 

by authorized users located anywhere. 

• Scan cover sheets, utilizing Xerox DataGlyph technology, allow easy scanning of 

single documents or batches of documents from any network scanner. Using a scan 

cover sheet, users can scan new documents and document versions, scan to their 

personal collection, and scan to designated collections and workspaces (DocuShare 

CPX only). The DataGlyph on the scan cover sheet directs the scanned document to 

the correct DocuShare location. 

 

• The DocuShare Email Agent, together with an email application, enables users to 

share email content by sending messages and attachments to DocuShare collections, 

workspaces (DocuShare CPX only), other users, and groups. Sending email messages 

to collections and workspaces lets users easily share, store, and retrieve messages as 

needed. 
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In addition, the Email Agent supports receiving cover sheets as email with attached 

JPEG, TIFF, or PDF files so that users can send documents to DocuShare by e-fax or 

scan-to-email. The Email Agent recognizes the cover sheet's unique DataGlyph and 

files the scanned content accordingly. 

• A free EIP connector from TG Consulting leverages the Xerox Extensible Interface 

Platform™ (EIP) to enable users to access DocuShare document management 

features from the touch screen of an EIP-enabled Xerox WorkCentre. Using the EIP 

connector, users can scan new documents to DocuShare, retrieve documents stored in 

collections, and initiate document workflows from the device. This capability provides 

access documents when away from a computer. 

• The Content Intake Manager enables rapid, high-volume intake and incorporation 

of content from multiple sources, including scan workstations, e-forms servers, and 

production scan devices, supports ingestion of diverse content types and input into 

sophisticated workflows. 

• Tight integration with Xerox and third-party products, such as Xerox FreeFlow 

SMARTsend, Xerox SmartDocumentTravel, ScanFlowStore from X-Solutions, Kofax 

Ascent Capture, NSI AutoStore, Nuance PaperPort, Omtool Accuroute, and others via 

integration through DocuShare SDKs. 

Use Case—A paper-intensive government agency wants to cut paper use to save time, reduce 

storage, and prove that it’s taking steps to go “green.” The agency has one Xerox multi-

function printer (MFP), but also scan-to-e-mail devices from other vendors. It sets up the MFP 

with the EIP connector for simple direct scanning to DocuShare. This allows administrative 

staff to regularly scan mail received from the public into a “daily correspondence” folder. 

Employees also use scan cover sheets to scan documents into personal DocuShare folders, or 

into other target locations. They can scan from the MFP, or from other devices using scan-to-

email (the administrator assigns an email address to DocuShare). As a result, instead of going 

to a file cabinet or searching through papers on a desk, users simply search for a document in 

DocuShare. Additionally, with the documents stored in an electronic repository, disaster 

recovery plans can be implemented to protect their content. 
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Ad Hoc and Content-centric Collaboration 

• Threaded discussions and document commenting facilitate an exchange of ideas 

• WYSIWYG blogs and wikis enable easy collaboration and information sharing in a 

controlled, auditable environment; blogs can also be moderated, requiring entries to 

be routed for approval before publishing 

• Web-based collaborative workspaces enable organizations to assemble task-specific 

information, people, and reference material in a centralized area, with presence 

detection showing when a workspace member is logged in. 

• Email notification of new and changed content keeps work groups up-to-date 

• RSS feed support enables users to view updated content in collections and other 

types of containers outside of DocuShare 

Use Case—A large organization recently expanded by acquiring several smaller companies. It 

must now promote collaboration among groups who don’t know each other and use a variety 

of applications and operating platforms. A cross-organization project team, consisting of 

people in the U.S., Europe, and Asia, is working on a time-sensitive project to develop a new 

product. The team leader creates a DocuShare CPX web-based workspace with a wiki for 

developers to document the product design; they can also log daily activities in blogs or start 

discussions. When a team member sends email related to the project, he or she copies the 

workspace email address and all emails are saved in the workspace. Engineers can be notified 

by email or RSS feed when new documents or versions of project spreadsheets are added. 

Finally, when a manager in India checks in each morning, he can see through the presence 

icon whether any team members in the U.S. are currently on-line. 

Workflow and Business Process Automation 

• Wizard-based document workflow capabilities enable casual users, without IT 

assistance, to easily route documents for review, approval, or information and track 

the progress of routing tasks 



Xerox DocuShare Reviewer's Guide 9 

• Ability for business process managers to create content rules that determine and 

automate how content moves through an organization. A content rule can be created 

for any site object and defines an event that triggers a series of easily predefined 

actions to run automatically. For example, a content rule can move a scanned invoice 

to a specified collection once it has been approved. 

 

• Ability of process managers to establish rules for exporting documents to external 

servers and web sites, creating links to third-party applications or processes that 

require content but live outside the firewall 

• DocuShare Enterprise Workflow, available with the DocuShare Developer Network, 

enables system integrators to create custom workflows for advanced process 

automation needs. Based on Cardiff LiquidOffice™, DocuShare Enterprise Workflow 

provides a graphical workflow design studio for developing complex processes. 

• DocuShare LiquidOffice™ Connector adds on-line forms capability to DocuShare or 

DocuShare CPX, enabling capture, indexing, and rendition of information from 

electronic and paper-based forms and the ability to trigger workflows when forms are 

submitted 

Use Case—To streamline activities in a Human Resources department, process managers 

design a process for the acceptance, acknowledgment, review, and referral of job applications 

and resumes. DocuShare CPX automatically sends resumes via email and generates an email 

acknowledgment to the applicant; routes applications to the appropriate hiring manager; 

distributes documents to the appropriate people for consideration; places resumes in an 

interview folder; moves the resume to a hold file if rejected, and mails a response letter to the 

applicant. 
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Web Publishing 

• “Guest” and “Read-Only” access supports Web information publishing for external 

and internal constituents—a partner extranet or public internet website can be 

enabled at no extra charge 

• Addressable Web links for any stored content (DocuShare handle) 

• Automatic HTML conversion, so users across platforms can view a document’s 

content without the application installed on their desktop 

• Web-based site administration 

• Customizable, template-driven DocuShare Web interface 

• Customizable wiki pages for easily updated Web 2.0 publishing 

•  Integration with portals through JSR168 support, Web parts for Microsoft Office 

SharePoint Server (MOSS) portal, and DocuShare SDKs 

Use Case—A company with an extensive intranet site wants an easy way for people to 

publish documents internally, to share across groups.  When a worker uploads a document to 

DocuShare, she can email the link to others rather than sending the document as an 

attachment. Through “Guest” and “Read-Only” licensing, many people across the company 

can access common documents without needing a DocuShare license, viewing them as HTML 

if they do not have a particular desktop application. Other internal websites can also link to 

them, and for frequently updated documents like policies or procedures, users make changes 

without going to a webmaster. The administrator customizes DocuShare’s Web UI to add the 

corporate logo, and customizes several wiki pages with graphics and colors to suit particular 

departments. 
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Administration Interface 

For administering a site, DocuShare provides a consistent browser-based interface that does 

not require Active X controls, Java applets, or applications such as Microsoft Management 

Console (MMC) for remote administration. This allows administrative tasks to be distributed 

among workers and performed regardless of location or access to specific tools. Additionally, 

an administrator can manage multiple DocuShare sites from a single computer. 

Administrative functions that can be performed using the interface include: 

• object and metadata management 

• account management 

• LDAP or directory configuration 

• services setup including workflow management 

• content management 

• site customization and configuration 

• logging setup 

• third-party application setup and configuration. 

All Administration UI pages provide instructions for using the page. When add-on modules 

are enabled, pages for configuration and usage are added to the UI. 

This guide includes several tests for the administrator. For a complete overview of DocuShare 

administration, refer to the DocuShare Administrator Guide located on the DocuShare site 

Help Desk. 

Advanced Features and Add-on Modules 

DocuShare Developer Network (DSDN) 

The DocuShare Developer Network provides a suite of programming tools, documentation, 

support, and training for further development and customization of DocuShare. Its 

application program interfaces (APIs), integration components, J2EE architecture, and flexible 

programming options allow value-added resellers (VARs), system integrators (SIs), and other 

partners and customers to build collaboration, imaging, workflow, and compliancy solutions or 

industry-specific solutions. Developers can access DSDN resources at 

https://docushare.xerox.com/dsdn. 
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DocuShare Records Manager 

The DocuShare Records Manager add-on for DocuShare CPX 6.5 tightly integrates records 

management capabilities with the Web and Client interfaces, to support organizational 

compliancy and governance. The product is designed so that organizations can assign 

classification, declaration, and administration responsibilities on a user-by-user basis, 

simplifying the process by assigning more complex tasks to dedicated records managers. 

Unlike competitive products, DocuShare Records Manager enables users throughout an 

organization to easily classify electronic documents and email messages as records during 

any part of a work process, knowing that a qualified records manager will review the 

classification before the items officially become records. 

DocuShare Content Encryption 

DocuShare Content Encryption for DocuShare CPX 6.5 enhances site security by providing 

automatic content encryption of all uploaded documents. Document content is encrypted 

using a symmetric key cryptography algorithm before it is written to the content store. The 

encryption keys are stored in the relational database, with one unique key per document 

version and rendition. Document content is decrypted when it is accessed through standard 

DocuShare interfaces. This prevents any system intruders from reading document content, 

even if they gain access to the storage server either remotely or physically. 

DocuShare High Scalability Kit 

The DocuShare High Scalability Kit allows customers to scale their DocuShare sites to volumes 

above 50 million documents while maintaining optimal performance. Recommended for sites 

with more than 5 million documents, the High Scalability Kit enables the configuration of 

underlying subcomponents, such as the database, search index, and file system, to support 

the efficient handling of large volumes of documents. Also included with the kit is an elevated 

level of customer support to ensure successful implementation and continued operation. 

DocuShare OCR (Optical Character Recognition) 

The DocuShare OCR add-on module to DocuShare CPX 6.5 offers server-side optical character 

recognition for scanned documents. The module provides “one-button” OCR conversion of 

captured documents, either through an end-user UI or programmatically, ensuring that all 

content in the repository is fully text-searched. 
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DocuShare Archive Server 

The DocuShare Archive Server enables automatic or manual archiving of out-of-date content 

on a separate DocuShare server and protects it from unauthorized access. Archived content is 

preserved its access controls, locations, fully searchable indexes, and other metadata. Using 

the familiar DocuShare search interfaces, users can search the Archive Server and restore 

archived content to the primary DocuShare server with a single click 
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Feature Comparison 

The following table provides a comparison of the key features available in DocuShare Express, 

DocuShare, and DocuShare CPX. 

Product Feature DocuShare 
Express 

DocuShare DocuShare 
CPX 

Full Text and Metadata Indexing    

Document Versions, Check-in / 
Check-out 

   

Access Control and Permissions    

Expanded Permission Set    

Notification of New and Changed 
Content 

   

Audit Trail – Query and Reporting    

Document Routing and Approval    

Integrated View of Document 
Content and Metadata 

   

Blogs / Wikis / Comments    

Scan via Cover Sheets to Collections 
and Documents 

   

Guest Access    

WebDAV Support    

Xerox Extensible Interface Platform 
(EIP) Support 

   

LDAP Support    

Third-party Integration    

French, German, and Spanish 
Language Packs 

   

Windows Platform    
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Product Feature DocuShare 
Express 

DocuShare DocuShare 
CPX 

Federated Search Support    

Integration with Microsoft Windows, 
Office, and Outlook 

   

Email Agent    

Database Connectors    

Linux / Solaris Platforms    

Archive Server  Add-on Add-on 

High Scalability Kit  Add-on Add-on 

Unlimited Guest  Add-on Add-on 

Enterprise Workflow    

Collaborative Workspaces    

Content Rules    

Document Export    

Content Encryption    

Records Manager   Add-on 

OCR Service   Add-on 
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New Features in Version 6.5 

Version 6.5 includes several new end-user features as well as significant performance and 

scalability enhancements.  The following are some of the primary new features of the 

DocuShare platform added since version 6.0. The end-user tests in this guide illustrate many 

of these additions. 

DocuShare 6.5 Platform: All Products 
• An expanded set of permissions offers additional levels of access to objects and 

object properties and permissions. An administrator can optionally configure a site to 

use six permissions for objects instead of three. Version 6.5 provides these new 

permissions: Read Properties, Read Content, Read History, Write Properties, Write 

Content, and Manage. 

• Usage quotas enable an administrator to assign limits to the amount of content a 

user can store on the site. Users can view their assigned quotas. 

• Color schemes called themes allow users to individually customize the look of 

DocuShare web pages. Four themes are provided. 

• Microsoft SQL Server 2005 Express Edition is the default database provided with 

DocuShare. 

• DocuShare index and search functions utilize the Autonomy IDOL Server. 

• Performance and scalability improvements. DocuShare now supports up to 50 million 

documents on a server. 

DocuShare Express 6.5 and DocuShare 6.5 
• Users assigned the DocuShare user level can create scan cover sheets for collections. 

• Users assigned the DocuShare user level can view an object’s change history and a 

user’s activity history. 

DocuShare CPX 6.5 
• Users can edit content rules after they are created. An Edit link on the Properties page 

for a content rule allows users to make any changes. 
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Administration UI 
• New settings on the Site Configuration page let an administrator enable or disable 

the Content Map, Show All button, and personal trashcan.  

• A new Permissions page in the Admin UI provides options previously located on the 

Site Configuration page and includes new options for setting permissions. 

• A new access tracking operation, Failed Login, records when a login attempt failed. 

This operation appears on the Access Operation Tracking page in the Admin UI. 

New DocuShare Add-on Modules 
• High Scalability Kit—To support version 6.5’s increased ability to manage large 

volumes of content, a High Scalability Kit is available. The kit allows customers to 

scale their DocuShare sites to volumes above 50 million documents while maintaining 

optimal performance. Recommended for sites with more than 5 million documents, 

the High Scalability Kit enables the configuration of underlying subcomponents, such 

as the database, search index, and file system, to support the efficient handling of 

large volumes of documents. Also included with the kit is an elevated level of 

customer support to ensure successful implementation and continued operation. 
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Recommended Tests 

To facilitate a thorough review of the DocuShare platform, the following tests are 

recommended. If any assistance is required during the testing process, please use the Xerox 

technical support information provided in the Contact Information section of this document. 

DocuShare Web UI Tests 

Accessing DocuShare 

DocuShare is easily accessed through a Web browser. When you install DocuShare, it 

automatically creates the Web environment for you. Any authorized user can immediately 

add content, set permissions, and manage document processes. If a site is set up to allow 

guest access, non-registered individuals can browse and access unrestricted content. 

For most users, the Web UI is the preferred interface to DocuShare. Additionally, the 

DocuShare Web UI meets the U.S. government’s Section 508 guidelines for accessibility. 

The DocuShare Home Page provides a consistent portal for accessing all the DocuShare 

content, user accounts, features, and site administration tools. 
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Adding User and Group Accounts 

DocuShare provides two types of accounts: individual user accounts and group accounts. An 

administrator determines who can create each type of account on your site. When a user 

account is created, either by you or an administrator, it is assigned a user level (Read-Only, 

DocuShare, CPX). The user level controls the level of access to site content and functions. 

After the user account is created, the user level assigned to the account is indicated by the 

superscript letters appearing after the username: read-only, DS, or CPX. A site can include all 

three user levels. 

To add and manage content, you need a user account.  

Creating a user account 

1. On the navigation bar, click the Users & Groups link.  

2. Click the Add User link. 

 

3. On the Add User page, enter the following information: 

Username—The name you want to use to log into DocuShare. When creating objects, the 

username is specified as the object’s owner. Your username is not case-sensitive. 

Password and Password Confirm—The password you want to use to log into DocuShare. 

Your password is case-sensitive. 



20 Xerox DocuShare Reviewer's Guide 

Domain—An internal domain name. This field appears if your site uses the LDAP feature 

(for iPlanet/Sun ONE LDAP or Microsoft Active Directory). 

User Level— The level of access to site content and functions. We recommend creating at 

least one CPX user to enable features described in many of the tests in this guide. 

Last Name—Your last name. Users are listed on the DocuShare site by their first and last 

names. 

4. Enter any optional information. 

5. Click Apply. Your username appears on the navigation bar, indicating that you are logged 

in. 

6. Create another user account for use later. 
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Changing an account’s user level 

Using the Administration UI, an administrator can easily change the user level assigned to 

individual accounts. This allows a site to control which users can access content and perform 

specific functions as operational and business needs change. 
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Changing a user’s usage quota 

Usage quotas enable an administrator to limit the amount of content that a user can store on 

DocuShare. Users can view their assigned quotas as well as check their current usage. 

An administrator can limit: 

• The number of all documents (includes email attachments, documents attached to wiki 

pages, etc.). 

• The size, in MB, of document content (includes content in all renditions of all versions of 

documents). 
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Creating a group account 

1. On the navigation bar, click Users & Groups. 

2. Click the Add Group link. 

 

3. On the Add Group page, enter the following information: 

Title—A name for the group. The name can contain spaces and punctuation marks, and 

can be identical to another group name. 

Domain—An internal domain name. This field appears if your site uses the LDAP feature 

(for iPlanet/Sun One LDAP or Microsoft Active Directory). 

4. Enter any optional information. 

5. Click Apply. 

The Pick Members for Group page appears. On this page you choose the users and groups 

who will be the group members. 

6. In the Search field, enter part of the username of the second user account you created; 

then click Go. 
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7. In the Possible Users/ Groups field, select the user and click the Add button. 

 

The user displays in the Selected Users/Groups field. 

8. Click Update. 
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Adding Content to DocuShare 

You add content to repositories called collections. By default, a site includes four top-level 

collections. An administrator can customize the site top-level collections. The type of content 

that you can add to collections includes: documents, email messages, and files; URL hyperlinks 

to other internal or public web sites; wikis; blogs; calendars; discussions; saved search queries; 

and other collections. 

After you add an object to DocuShare, the object is assigned a unique handle (URL). This 

allows you to access any object on the site using its handle, as well as share the handle with 

others when you want to provide a link to content. 

To add content, you must be logged in and have the appropriate permission to the collection. 

An administrator can set up a site to use either three or six permissions for access control. The 

use of six permissions provides finer access control to content and object information, such as 

properties and change history. DocuShare provides the permissions described below. 

Three Permission Site Six Permission Site 

Reader allows the user or group to read 
the content of the object and view its 
associated properties and permissions. 

Read Properties allows the user or 
group to view the object’s properties 
and permissions. 

Writer allows the user or group to 
change the object’s properties and add 
new objects, including new versions of 
documents. 

Read Content allows the user or group 
to read the content of the object. 

Manager allows the user or group to 
delete the object, and change the 
object’s permissions and owner. 

Read History allows the user or group to 
view the object’s change history. 

 Write Properties allows the user or 
group to change the object’s properties. 

 Write Content allows the user or group 
to add new objects, including new 
versions of documents, and change the 
object, such as its location. 

 Manage allows the user or group to 
delete the object, and change the 
object’s permissions and owner. 

 



26 Xerox DocuShare Reviewer's Guide 

Adding content via the Web UI 

Using the Add menu, you can create a variety of content on your site. You can create 

standard DocuShare objects and any custom objects an administrator creates. 

1. On the navigation bar, click Home. 

2. Open one of the top-level collections. 

3. From the Add menu, select Collection. 

 

4. On the Add Collection page, enter a Title for the collection. 
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5. Enter any optional information. 

By default, the new collection is assigned the top-level collection’s permissions. You can 

change the Initial Permissions before adding the collection. 

6. Click Apply. 

7. Click the collection to open it. 

8. Use the Add menu to add objects to the collection. 

Setting permissions on content 

By default, when you add an object to DocuShare it is assigned the container’s permissions. 

As the user who added the object, you are its owner and can change the object’s permissions. 

1. From the object’s More Actions menu, select Permissions. 

 

2. On the Permissions page, click the Change Access List button. 

 

3. On the Change Access List page, select the type of account you want to display from the 

Show field: Users, Groups, or Both. 
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4. Do one of the following: 

• To find a specific account, enter part of the user’s first name, last name, or username 

or the group’s title in the Search field. Click the Go button. 

• To list all accounts, click Show All (if displayed). 

• To display your favorite accounts, click Show Favorites. 

5. In the Possible Users/Groups field, select the accounts to add to the access list and click 

the Add button. To select multiple accounts, use the CTRL key (Windows) or the 

Command key (Macintosh). 

6. In the Selected Users/Groups field, select any accounts that you want to remove from 

the access list and click the Remove button. 

7. Click Update Access List. 

The Permissions page appears, displaying the new access list. 

8. Check the permission boxes you want for each user and group displayed in the access list. 

9. Click Apply. 

Adding content using a scan cover sheet 

Scan cover sheets enable you to scan paper documents directly to designated documents, as 

new document versions; collections, including your personal collection; and workspaces. 

To set up the scan cover sheet feature: 

1. Log into DocuShare as an administrator. 

2. On the DocuShare navigation bar, click Admin Home. 

3. From the Administration menu, go to Site Management | Site Configuration and make 

sure Enable SMB Scanning is set to Yes. 

4. From the Administration menu, go to Services and Components | Content Intake | Edit 

and select GlyphScan from the Type menu. 

5. On the same page, select Enabled, and then click Update. 

The scan cover sheet feature is now available to users. 

Note: If this procedure does not enable the scan cover sheet feature, go to Services and 

Components l Scan and make sure Integrate Scan Cover Sheet Feature with Scan 

Service is set to Yes. 
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To create a scan cover sheet: 

1. Do one of the following: 

• To create a cover sheet for a document, collection, or workspace, locate the object. 

Then click the object’s Properties icon. 

• To create a cover sheet for your personal collection, click your username on the 

navigation bar. 

2. On the View Properties page, click the Scan Cover Sheet link. 

3. Click the Create Scan Cover Sheet link. 

The cover sheet is created and opens in a separate window. 

 

4. Print the cover sheet. Then close it. 
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Accessing Content 

DocuShare provides a broad range of interfaces and methods for locating and accessing 

content. One method is to use the Content Map, which provides a hierarchical listing of site 

content (shown below). The site administrator controls whether or not to Additional methods 

for accessing content are included in this section. 
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Accessing content from My DocuShare 

You can quickly access content from a personalized home page called My DocuShare. The 

page includes areas called portlets from which you can access features such as your personal 

collection, favorite calendars, personal trashcan (if enabled), favorite objects, groups, and 

routing tasks as well as the top-level site content. DocuShare CPX includes additional portlets: 

the workspaces you can access and the online meetings you scheduled. 

From any DocuShare page, click My DocuShare to access your personal home page.  
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Using quick search features to find content 

Using the search area on the navigation bar you can search for objects and content. The 

results are displayed in an ordered list, similar to the display of a collection’s contents. 

1. On the navigation bar, enter one or more words in the Search field. 

2. Depending on the page from which you are running the search and whether or not your 

site is part of a federation, select a search scope from the In menu. 

3. Click the small triangle next to the Search field to display the quick search options. 

 

4. Change any of the options to narrow your search and to control how the results are 

displayed. 

5. Click the Search button. 

The search results display. 
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Finding content using advanced search features 

DocuShare advanced search features allow you to further narrow a search by combining 

search terms using logical operators and by entering specific date ranges. 

1. On the navigation bar, click the Advanced link to display the Advanced Search page. 

 

2. Under Search Text Contained In, enter a word that appears in a document on your site 

in the field next to contains. 

3. Click + add search term. 

4. For the second search term, enter your last name in the field next to contains and change 

Any Part to Owner. 

5. In the Search Within field, select This Site Only. 

6. Select the Maximum Results and the Sort Results. 

7. For Object Types to Search, select Limit search to selected object types and click 

Document. 

8. Click the Search button. 

The search results display. 
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Receiving notification of new or changed content 

Notifications allow you to receive an email message when a change occurs to an object. You 

can add a notification for any site object. You can quickly add a simple notification to have 

DocuShare email you when new content is added to an object, or you can choose advanced 

options to customize the notification. 

1. Locate the object for which you want to add a notification. 

2. Click the object’s Notifications icon. 

 

3. On the Notifications page, click Create a New Notification. 

4. From the Period menu, select a notification time period. 

 

5. Click Apply. 
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Creating a Simple Workflow Using Document Routing 

Content can be easily distributed for approval and review using DocuShare's document 

routing and workflow features. Running on top of a true workflow application (some systems 

use a simple messaging subsystem), the routing and workflow features provide significant 

scalability. For maximum flexibility and user friendliness, DocuShare provides full control to 

users enabling them to create, share, and manage Routing Slips. 

When creating a Routing Slip for a document or one of its versions, you can define a single 

routing step or several sequential steps. A single routing step consists of one type of action, 

such as sending a document to users for approval. A multi-step routing task enables you to 

automate a document process. For example, you can create a routing task to send a 

document to a group of users for their review and comment before sending the revised 

document for approval. 

To test the routing and workflow features, it is recommended you create several “dummy” 

user accounts so you can originate and receive a routing task. 
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Routing a document 

1. Click the Route command from a document’s More Actions menu. (The Route command 

is not available if the document is locked.) 

A Routing Slip appears. 

 

2. Under Routing Action, choose one of the following: 

• Approve or Disapprove—Requires users to approve or not approve the document. 

• Review and Make Changes—Allows users to provide comments and a revised version 

of the document. Click Share Changes with Recipients if you want each recipient to 

see the previous recipient’s changes. 

• Acknowledge Receipt—Provides the document to users for information and requires 

the users to confirm receiving the document. 

• Information—Provides the document to users for information only. 
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3. Depending on the routing action you selected, choose one of the following Routing 

Orders: 

• In Order—Routes the document to users in the order in which they are listed in the 

Selected Users/Groups field. If a user does not approve the document, it is not routed 

to subsequent users. 

• At the Same Time-Single Reply—Routes the document to all users simultaneously 

and only one user’s reply is needed to complete the routing task. 

• At the Same Time-All Reply—Routes the document to all users simultaneously and 

all users must reply to complete the routing task. 

• At the Same Time-Majority Reply—Routes the document to all users simultaneously 

and more than half of the users must reply to complete the routing task. 

4. Under Message, enter a Subject and a message in the Comments field. 

5. Click Next to go to the Add Recipients page. 

6. In the Show field, select the type of account you want to display in the Possible 

Users/Groups field. 
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7. Do one of the following: 

• To find a specific account, enter part of the user’s first name, last name, or username 

or the group’s title in the Search field. Click the Go button. 

• To display your favorite accounts, click Show Favorites. 

8. In the Possible Users/Groups field, select the accounts to add to the list of recipients and 

click the Add button. To select multiple accounts, use the CTRL key (Windows) or the 

Command key (Macintosh). 

9. In the Selected Users/Groups field, select any accounts that you want to remove from 

the list of recipients and click the Remove button. 

10. To show the members in a group, select the group in the Selected Users/Groups field and 

click Show Group Members. The group members replace the group title and the routing 

task is sent to each user and not to the group. 

11. To reorder the recipients in the Selected Users/Groups field, select an account and do 

one of the following: 

• To move the recipient before another recipient, click Move Up. 

• To move the recipient after another recipient, click Move Down. 

12. Click Next to go to the Choose Escalation and Notification page. 

13. Under Escalation, choose any of the following: 

• If Not Complete—Specifies a completion date for the routing task. 

• Then Escalate—Specifies an escalation action if the routing task is not complete by 

the specified date. 

14. Under Notify Me, choose any of the following: 

• Of Escalation—Notifies you of the escalation action. 

• Of Task Progress—Notifies you of the routing status after each user action. 

• When Task Is Complete—Notifies you when each routing step is complete. 



Xerox DocuShare Reviewer's Guide 39 

To check for notifications, you click the My Tasks link on the navigation bar and select 

Tasks Assigned to Me. 

 

15. Click Done to go to the Routing Summary page. 

16. Review the routing information for the task and then do one of the following: 

• Click Submit to start the routing task. 

• Click Back to change any of the routing information. 

• Click Add Step to add another step to the routing task. 

Note: Before submitting the routing task, you can save the Routing Slip. Click Save Routing 

Slip. Enter a name for the Routing Slip and keep Save as private selected if you do not want 

to share the Routing Slip with other users. Then click OK. 
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Viewing and responding to your tasks 

To view the tasks assigned to you, you can click the My Tasks link on the DocuShare 

navigation bar or click My DocuShare. You also can receive an email message with a URL to 

the task. 

1. Do one of the following: 

• On the navigation bar, click My Tasks. From the Show menu, select Tasks Assigned to 

Me. Any task marked Request is a task assigned to you. 

• On the navigation bar, click My DocuShare. The tasks assigned to you display. 

2. To view a task, click its Description.  

A window appears displaying your task with a link to the document.  

 

3. Click the document title to open the document. 

If the document was sent to you for review, you can edit it and attach a draft version by 

clicking the Properties icon that appears to the right of the document. 

4. Close the document. 

5. Enter a message in the Comments field and click the appropriate button at the bottom of 

the window to complete the task. 
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Creating a More Complex Workflow Using Content Rules (CPX Only) 

DocuShare CPX content rules go beyond basic document routing capabilities, enabling 

business users to easily define and modify advanced, document-centric workflows. You create 

a content rule to have an action run automatically when an event occurs regarding specific 

content. For example, you can create a content rule for a document to copy it to another 

collection when a specific document property is changed. DocuShare provides a wizard to help 

you create a content rule.  

Creating a content rule 

1. Locate a document on the site. 

2. From the document’s More Actions menu, select Content Rules. 

 

3. On the Content Rules page, click Create a New Content Rule. 

 

4. Give the content rule a title and click Next. 

5. From the When menu, select Properties edited. Then click Next. 
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6. Under Where the content property conditions apply, select Keywords from the menu 

and type published in the box after contains. Then click Next. 

 

7. From the Action for Content Involved menu, select Copy (add location). Then click Next. 

 

8. Under Copy to location options, click Show All. 

9. Select a collection and click Next. 

10. On the Completion Settings page, click Done. 

A View Properties pages appears, displaying a summary of the content rule. 

To test the content rule, edit the document’s Keywords property by adding the word 

published. Then go to the collection you specified in the content rule to see a copy of the 

document. 
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Note: More advanced workflows also can be created using the Workflow Studio, which is 

available on the DocuShare Developer Network. 

Changing a content rule 

After a content rule is created, you can easily change any of its settings. In this exercise you 

edit the content rule you just created. 

1. From the document’s More Actions menu, select Content Rules. 

2. On the Content Rules page, click the content rule title. 

3. On the View Properties page, click the Edit link. 

4. Go through the Edit Content Rule pages and make the changes you want. 
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Using Social Collaboration Features 

DocuShare social collaboration features include the ability to add weblogs (blogs) and wikis to 

your site and to add comments to documents. When adding a blog, you can choose to have it 

moderated, which requires entries to be approved before users can read them. 

To format blog, wiki, and comment content, DocuShare provides a WYSIWYG editor. 

Additionally, an HTML designer can customize blogs and wikis using cascading style sheets. 

Adding a blog 

1. Open a workspace or a collection. 

2. From the Add menu, select Weblog. 

3. On the Add Weblog page, enter a title for the blog. 

4. Change any of the default property values that control the formatting of the blog and the 

entries. 

5. Click Apply to add the blog to the container. 

6. Click the blog to open it. 

7. Click the Add Entry link. 

8. Create an entry by entering a title and a description (the body of the entry). Then click 

Apply. 

9. You can post a comment on an entry by clicking the entry title and then clicking the Add 

a comment link. 
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Adding a wiki 

1. Open a workspace or a collection. 

2. From the Add menu, select Wiki. 

3. On the Add Wiki page, enter a title for the wiki. 

4. Click Apply. 

The wiki is added to the container. 

5. Click the wiki to open it. 

The Add WikiPage appears and the page is titled HomePage. 

6. In the Description field, enter the page content using the WYSIWYG editor. To create a 

link to another page, enclose the page title within double square brackets. 

 

7. Click Apply. 

The wiki page appears. Text followed by a question mark is a link to another wiki page. 

 

8. Click the text to add content to the linked page. 

9. Enter content in the Description field and click Apply. 
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Adding a comment to a document 

Comments allow you to quickly add information about a document. 

1. Locate a document. 

2. Click the Comments icon that appears to the right of the document’s title. 

 

3. On the Add Comments page, enter a title and a description (the comment text). Then click 

Apply. 

The comment appears on the Comments page. On the Comments page, you can read and 

add more comments. 
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Using Workspaces for Project and Team Collaboration (CPX Only) 

A DocuShare CPX workspace provides a shared area for project and team collaboration, 

allowing you and other workspace members to gather and manage shared content, access 

collaboration tools to facilitate your work, and communicate with each other. A workspace 

includes four areas called portlets: 

• Content portlet—The area in which you add and manage shared content. 

• Shortcuts portlet—Displays links to frequently used objects. 

• Calendars portlet—A combination of the calendars in the content portlet. 

• Membership portlet—Lists the users who are members of the workspace membership 

group. A presence detection feature enables you to see which other members are logged 

in. The user icon is grayed when the user is not logged in. 
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Adding a workspace 

Administrators can add top-level workspaces, in which users can add other workspaces. In 

addition, users can add workspaces to their personal home page, My DocuShare. 

1. Go to the DocuShare home page. 

2. In the Communities area, click more under Workspaces. 

3. On the Workspace Directory page, click Add a Workspace. 

4. On the Add a New Workspace page, you can choose from two types of workspaces. Select 

the workspace you want to add and click Next. 

 

5. In the Title field, enter a name for the workspace. 

6. Optionally, add a description and decide whether or not you want to add the workspace 

to your favorites on My DocuShare. 

7. Click Done. 

The workspace home page appears. You are listed as the workspace’s first member in the 

membership portlet. 

Assigning workspace members 

1. On the workspace home page, click the Membership heading. 

2. At the bottom of the page, click the Change Membership link. 

3. In the Search field, enter part of the username of the second user account you created; 

then click Go. 

4. In the Possible Users/Groups field, select the account to add to the group and click the 

Add button. 

5. Click Update. The Members page appears and lists the user you added. 
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Managing Document Versions and Tracking Changes 

DocuShare provides a rich set of document management features allowing you to collaborate 

on document content by adding new versions, edit the properties (metadata) associated with 

documents, and track all changes to documents. 

Document collaboration features include document check out and locking, which ensures that 

only one user at a time edits a document, and version management. 

Adding a new document version 

1. Locate a document. 

2. Click the Upload a New Version icon that appears to the right of a document’s title. 

 

3. On the Add Version page, click the Browse button. 

 

4. Navigate to the location on your local drive that contains the document you want to add 

as a new version, select it, and click Open. 

The path to the document appears in the Filename field. 

5. In the Title field, you can change the document title. By default, the new version is 

assigned the original document title. 

6. Optionally, enter a comment in the Version Comments field. 

7. Click Apply. 
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Viewing a document’s version history 

The Version History page shows all saved versions of a document. By default, DocuShare 

saves four versions of a document. However, on a per-document basis, you can change the 

maximum number of versions to save. 

1. Click the document’s Properties icon. 

 

2. Click the View History link. 

The page displays all saved versions of the document. 

 

3. To view a specific version of the document, click its type or version number. 

4. To return to the Version History page, do one of the following: 

• If the document opened in a separate window, select Exit from the File menu. 

• If the document opened within the browser window, click the browser’s Back button. 
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Viewing a document’s change history 

DocuShare tracks all changes to site objects, which provides a history of the changes to 

objects. You can view the changes to any object to which you have Reader permission. 

1. Locate the document whose change history you want to view. 

2. Click the document’s Properties icon. 

3. On the View Properties page, click the Change History link. 

4. From the Change menu, select the type of change you want to view. 

 

5. Do one of the following: 

• Enter part of a name in the Search for User field and then choose the user from the 

Select User menu. 

• Click Show All and then choose the user from the Select User menu. 

• Choose All from the Select User menu. 

6. From the Show Last menu, select the number of change events to display. 

7. To display the activity during a specific date range, enter start and end dates. 

8. Click Go. 

Information about the change displays. You can click Show as XML to convert the information 

to Extensible Markup Language (XML) format for use with other applications. 
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Viewing a document and its properties 

DocuShare provides you with a side-by-side view of a document’s content and properties. 

Additionally, you can edit a document’s properties in this view. 
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Exporting Documents (CPX Only) 

An administrator sets up locations on external servers to which you can export documents. 

You can export any documents that you want to make available to users and applications 

outside the firewall. 

Exporting a document 

1. Locate the document or documents that you want to export. 

2. Click the checkbox that appears next to each document’s title. 

3. From the Edit Selected menu, select Export Document. 

The Confirm Export Document page appears. 

4. In the Location field, select the external location for the document. 

5. Click the Confirm button. 
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Searching Multiple DocuShare Repositories 

DocuShare supports a federated environment, which enables a site to link to a community of 

DocuShare sites. This feature allows users to search multiple DocuShare sites and share 

content among users of the member sites. It is very easy for an administrator to connect 

many DocuShare servers, so that different workgroups within a company can make their 

content widely available to all. 

A DocuShare administrator creates a federation and invites other DocuShare sites to join. 

Each member site is managed by an administrator, who can cancel the membership at any 

time. Site users can map a federated site and, if allowed, create an account on a federated 

site. Once mapped to member sites, a user can search for and access content across the 

federation. 
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DocuShare Client Tests 
Xerox DocuShare Client seamlessly integrates DocuShare's content management features 

within the Microsoft Windows environment. This allows users to access DocuShare features 

using familiar Windows interfaces and applications such as Explorer, Office, and Outlook. 

Key features 

• Mapped DocuShare servers and collections appear in Windows Explorer and Outlook 

• Ability to drag and drop documents and folders from local and network drives to 

DocuShare 

• Ability to drag and drop email messages and attachments from Outlook to DocuShare 

• Document check-out/check-in 

• Integration with Office applications 

• Search capabilities 

Note: DocuShare also provides a WebDAV integration feature that enables users to access 

DocuShare content on computers with operating systems that support WebDAV. No client 

software is required. 
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Mapping a DocuShare server 

DocuShare Client provides a wizard to guide you in mapping a DocuShare server. 

1. Open My DocuShare Places. Depending on your installation, it appears either on your 

Windows Desktop or in My Computer. 

2. Double-click Map Server. 

 

3. Follow the steps in the Map Server wizard to map a DocuShare server. 

4. The mapped server appears in My DocuShare Places and in Microsoft Outlook’s Folder 

List. 
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Adding content 

Adding content to DocuShare using the Client is easy. You can use wizards to create new 

DocuShare objects, such as collections, documents, and URLs, and drag and drop files and 

folders from your file system to DocuShare. 

Adding a collection 

1. Double-click the server to open it. 

The top-level site content and your personal collection appear. 

2. Double-click a collection. 

3. In the collection, right-click your mouse and select Collection from the New menu. 

4. Follow the steps in the DocuShare New Collection wizard to add a collection. 

 

Adding a document from your file system 

1. Open My Computer. 

2. Select one or more files and drag and drop them into your collection. 

Adding a folder with files from your file system 

1. Open My Computer. 

2. Select a folder that contains files and drag and drop the folder into your collection. 
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Adding a document from a Microsoft Office application 

1. Open a document in an Office application. 

2. From the application’s File menu, select DocuShare and then Save As. (If you are using 

Office 2007, click the Office Button and select Save to DocuShare.) 

 

3. In the Save DocuShare Document window, navigate to and select the collection in which 

you want to save the document. 

4. In the Title box, enter a document title. 

5. In the Summary box, enter an optional summary of the document. 

6. Click OK. 
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DocuShare has established a link between the document that is open and the collection, 

but has not checked in the document yet. 

7. To check in the document (save it as a new version) select Close from the File menu. The 

DocuShare Checkin wizard opens. 

 

8. Follow the steps in the DocuShare Checkin wizard to add the document. 
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Sending a document from a Windows desktop folder 

1. Open My Computer. 

2. Open a folder and right-click the document that you want to send. 

3. From the menu, select Send To and then click DocuShare. 

4. In the Send To DocuShare window, click Send. 

 

5. In the Browse for Folder window, navigate to and select the collection to which you want 

to send the document and click OK. 
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6. In the Send To DocuShare window, the Status area displays Done when the document is 

sent. 

7. Click Close to close the Send To window. 

Adding an email message with an attachment using DocuShare Client Outlook 

integration 

Using DocuShare Client’s Outlook integration feature, you can easily drag and drop email 

messages to collections. When adding an email message to a collection, the message and 

attachment are indexed separately, enabling you to search for each object. 

DocuShare users without Outlook can read email messages that were dragged from Outlook 

to DocuShare using their Web browser or DocuShare Client. 

1. Open Outlook. 

2. In Outlook's Folder List, open your DocuShare server and navigate to your collection. 

3. In an Outlook email folder, select an email message that includes an attachment. 

4. Drag and drop the message into your collection. 

Accessing content 

Accessing content from a collection 

1. Double-click your collection to open it. 

2. Double-click one of your documents to launch the editor application and open the 

document. DocuShare may lock the document when you double-click it, depending on 

how you have the configured DocuShare Client properties. 

3. Close the editor when you are finished. 
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Accessing content directly from a URL 

If you are given the URL to a collection, you can access the collection from My DocuShare 

Places. 

1. In your browser, go to a DocuShare server and open a collection. 

2. Copy the collection's URL from the Address or Location field. 

3. In My DocuShare Places, select Go to DocuShare URL from the Tools menu. 

 

4. In the Go to DocuShare URL window, paste your URL in the field. 

 

5. Click OK. 

The collection opens in My DocuShare Places. 
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Creating a shortcut to a collection 

If you frequently use a specific collection, you can map it to My DocuShare Places. To map a 

collection, the server on which the collection is located must be mapped. 

1. In My DocuShare Places, double-click Map Collection. 

2. In the Map Collection window, select the server that contains your collection and click OK. 

 

3. In the Browse for Folder window, navigate to and select the collection. Click OK. 

 

The collection appears in the server list. 
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Changing content properties 

DocuShare Client features allow you to easily change content properties and access 

permissions. Additionally, it provides a unique Properties subwindow that shows information 

on object properties and, if the object is a document, a rendition of it, as shown below. 

Note: If the Properties subwindow is not displayed, press the SHIFT key and click the View 

Properties button on the toolbar. 
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Changing an object’s properties 

1. Navigate to and open a collection. 

2. Right-click a document and select Properties. 

3. Change any of the document's properties by entering values in the tabbed Properties 

window. 
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Changing access rights 

1. Right-click a file or collection and then click Properties. 

2. Click the Permissions tab. 

3. The Access List shows the users and groups who have access to the object. 

 

4. Click the Edit with Browser button to change the Access List. 

5. On the Permissions page, click the checkboxes next to the user or group whose 

permissions you want to change; then click Apply. 

6. Click OK. 
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Changing content location 

In addition to using drag and drop to copy and move objects between collections, you can 

drag and drop an object and create a shortcut link to it. After creating a shortcut link, 

although the object appears in more than one collection, it is stored in the DocuShare 

database as a single object. Therefore, when you make any kind of change to the object, all 

instances of the object are changed. This enables users to more easily manage content that 

appears in several locations. DocuShare’s handling of object shortcuts is significantly more 

robust than Windows Explorer standard shortcut features. 

Before you begin, open a second My DocuShare Places window or display the Folders list. 

1. Right-click a document and then click Properties. 

2. Note the document’s handle number (e.g. File-123) and click Cancel. 

3. Right-click the document and drag it to another collection. 

4. From the menu, select Create Shortcut(s)/Link(s) Here. 

 

5. Open the collection to which you dragged the document. The document appears in the 

collection. 

6. Right-click the document and then click Properties. Note that the document’s handle 

number is the same as the original document’s number. 
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Creating user and group accounts 

Among document and content management products, DocuShare is unique in the level of 

control it provides to users. For example, an administrator can configure a DocuShare site to 

allow users to create new user accounts for others. With this capability, users can effortlessly 

add content, create user accounts, and set permissions from a single Windows location. 

1. Right-click an object and then click Properties. 

2. Click the Permissions tab. 

3. On the Permissions page, click the Add/Remove button. 

4. Click New User. 

 

5. Enter the user's account information in the required fields. 
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6. Click OK. 

7. Click New Group. 

8. Enter a title for the group. 

 

9. In the Members box, select the users you want to include in the group. 

10. Click OK. 

11. In the Add/Remove DocuShare Users and Groups window, click OK. 

The user and group appear in the object's access list. 
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Setup and Software 
Installation 

DocuShare 6.5 / DocuShare CPX 6.5 Minimum Requirements 

Note: These are MINIMUM configurations required to run DocuShare. It is recommended 

that the server hardware configuration be sized based on expected network traffic, number of 

concurrent users, and volume of data. 

Intel or AMD Platforms 

• Windows 2003 Server R2 or SP2 Standard and Enterprise (32- and 64-bit) 

• Windows 2008 Server Standard and Enterprise (32- and 64-bit) 

• Red Hat Enterprise Linux ES 5 (32- and 64-bit) 

• 3.0 GHz Intel Pentium 4 or AMD Athlon MP processor or better 

• 3 GB RAM or higher (32-bit) / 4 GB RAM or higher (64-bit) 

• 20 GB of free disk space 

• Ethernet network interface 

Sun SPARC Platform 

• Solaris 10 with current patch clusters 

• UltraSPARC III processor or better 

• 4 GB RAM or higher (64-bit) 

• 20 GB of free disk space 

• Ethernet network interface 

Virtual Server 

• VMware ESX Server 

Web Browsers 

• Microsoft Internet Explorer 6 SP1 or 7 
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• Mozilla Firefox 2.0 or 3.0 

• Opera 9.0 

• Apple Safari 2.0 or 3.0 

WebDAV 

• Windows XP Professional with Office XP/2003/2007 

• Apple Mac OS X 10.5 

Web Servers 

• IIS 6 on Windows 2003 Server 

• IIS 7 on Windows 2008 Server 

• SunONE/Sun Java System Web Server 6.1 on Solaris 10 

• Apache Web Server 2.2.9 

Databases 

• IBM DB2 9.5  

• Microsoft SQL Server 2005 SP3 

• Microsoft SQL Server 2005 Express Edition 

• Oracle 10.2.0.x or 11 

• PostgreSQL 8.3.5 

LDAP 

• SunONE/Sun Java Directory Server 5.2 or 5.1 SP1 

• Novell eDirectory version 8.7.3.7 or 8.8 

• Microsoft Active Directory on Windows 2003 Server or Windows 2008 Server 

DocuShare Client 6.0.6 System Requirements 
• Microsoft Windows XP Professional with SP2; Microsoft Windows Vista (32-bit) with SP1 

or the Microsoft Visual C++ 2005 SP1 Redistributable Package (x86) 

• Microsoft Office XP with SP3; Microsoft Office 2003 with SP3; Microsoft Office 2007 

• Microsoft Outlook 2003 or 2007 

• Microsoft Internet Explorer version 6 or higher 
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• TCP/IP network connection to a DocuShare or DocuShare CPX server running version 5.x 

or higher 

• 256 MB RAM (minimum); 512 MB RAM (recommended) 

• 50 MB free disk space for program files 

• 64 MB (minimum) free disk space on the installation drive for work-in-progress files 

Installation Overview 

DocuShare 6.5/DocuShare CPX 6.5 is relatively simple to install and can be up and running in 

a few hours.  Specific installation instructions are provided in the Installation Guide included 

with the DocuShare software. If additional guidance is required, please contact the Xerox 

technical contact provided in the Contact Information section of this document. 

Installing and using the DocuShare Client with DocuShare can greatly enhance the user 

experience. Instructions for installation of the Client are provided on the DocuShare site Help 

Desk page. 
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